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Introduction 
The barcoded flu clinic system was introduced in 2012 and has been used successfully over a number of 

years in several practices. It involves sending each patient an invitation letter with a barcoded, tear off 

ticket which they subsequently present at the practice flu clinic. The tickets are used to populate a list of 

patients, to which vaccination data is added as a batch process. The system is highly efficient and has 

the following benefits: 

 No appointment booking is necessary 

 Invitation letters can provide detail about the vaccine and the vaccination process 

 Invitation letters can be formatted so that patients can update their contact details 

 Patient transit through clinics is rapid 

 Face to face contact is minimal 

 Data entry is highly efficient 

 No IT hardware is required on site  

 Can be used for clinics where patients from multiple GP practices attend 

General Overview 

Pre-Clinic Process 

Letters are sent inviting patients to attend open (unbooked) clinics. 

Clinic Process 

Patient brings the tear off ticket to clinic and hands it to the clinician administering the vaccination 

Post-Clinic Process 

Tear off ticket is scanned, adding the patient’s NHS number to a list 

The list is imported into EMIS Web and the flu vaccination details are added as a batch process 

Creating the letter 
The letter should be created in Word, accessed via Template Manager/Resource Publisher in EMIS Web. 

It should comprise of an invitation and a tear-off ticket: 

Invitation  

The top section of the letter should detail: 

 Patient name 

 Patient address 

 The importance of vaccination 

 Advice about side effects 

 Reassurance e.g. infection control measures during COVID-19 pandemic 

 Advice to contact the practice if allergic to hens’ eggs 

 Clinic Dates and venues 

 Advice about how to prepare e.g. what to wear 
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Ticket 

The bottom section of the letter is the “ticket” which the patient will take to the vaccination clinic. This 

should detail: 

 Name 

 Patient number 

 NHS number 

 Barcoded NHS Number x2 

 Current contact details with space for the patient to update their details 

 Age and/or any other information to indicate which vaccine/s the patient should receive 

o If it is intended the patient should receive more than one vaccination e.g. pneumococcal 

and flu, list the recommended vaccines with left and right arm tick boxes next to them 

so that the clinician can indicate which vaccines were actually administered and to 

which body site. Alternatively you could issue separate tickets for each vaccination. 

 
Example Letter 
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Adding the Barcode 

How barcodes are constructed 

A barcode is merely a font but must have asterisk at each end for a barcode scanner to recognise it. 

e.g. 123456789 must be changed to *123456789*  

 Also any standard keyboard character should be added at the end to prevent the empty space after the 

number from being read as a “return key” e.g. *123456789*x 

Both the number and the asterisks should be highlighted and the font changed to “Free 3 of 9” barcode 

font (note that the “x” is not highlighted) 

         *123456789*x         *123456789*x 

Tip: It is worthwhile to experiment using different sizes of font to see which works best with your 
barcode scanner 

 

Adding the Free 3 of 9 Barcode Font to Your Computer 

The Free 3 of 9 font must be installed on your computer. It can be downloaded from: 

https://fonts2u.com/free-3-of-9-regular.font 

 Open the downloaded file and click “Install” in the top left corner of the window. Contact your 

local IT Department if the installation is blocked by security software. 
 

Barcoding the NHS Number Merge Field in EMIS Web 

Following the convention described above: 

 Insert the NHS Number merge field and remove any spaces at the end. 

NHS Number 

 Add an asterisk to each end of the merge field 

*NHS Number* 

 Add any keyboard character, immediately after the right-hand asterisk 

*NHS Number*x 

 Highlight the asterisks and merge field but not the additional character 

 

 Change the font to “free 3 of 9”  
 

The end result looks a little odd due to the presence of lower case characters in the merge field 

which are not bar code compatible; do not be perturbed by this. When the document is merged, 

the EMIS merge field will be replaced by numbers and the barcode will appear as expected 

*NHS Number*x (before merging)        *111 111 1111*x   (after merging) 

https://fonts2u.com/free-3-of-9-regular.font
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Print, Test, Embed Font & Save 

 Test merge the document for a single patient and print it 

 Open Notepad and scan the barcode on the printed document 

 Compare the scanned NHS Number with the patient’s NHS number 

 Depending on your method of printing and dispatch, you may need to embed the fonts used in 

the document. The barcode font is not common to all computers so if the font is not embedded, 

the NHS number may be converted back to a standard text font when the final merge document 

is opened for printing. It is therefore recommended that the font is embedded. The method 

varies depending on which version of Word is installed on your computer: 

Word 2007 

With the document open: 

 Click the Office Button  (note this is next to the Home tab and partially obscured by the 

document title) 

 Click “Word Options”  

 Click “Save” (in left hand column) 

 Tick ”Embed Fonts in the File”  

 Save the change 

 Save the document template in the usual way 

 

Word 2010 

With the document open: 

 Click the File tab 

 Click “Word Options”  

 Click “Save” (in left hand column) 

 Tick ”Embed Fonts in the File”  

 Save the change 

 Save the document template in the usual way 
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Word 2013 

With the document open: 

 Select File and go to the tab called Options 

 Go to the save tab 

 Check "Embed Fonts in the file" 

 Save the change 

 Save the document template in the usual way 

Mail Merge 
You should use the mail merge function within EMIS web in the usual way. As different vaccines are 

recommended for different cohorts of patients, before merging, you should split your entire eligible 

patient cohort into smaller cohorts determined by the vaccinations they should receive. Separate mail 

merges should be performed on each cohort indicating the vaccine required on the ticket. 

Printing and Dispatch 
It is highly recommended that a mailing service is used to print and dispatch the letters. These services 

usually offer postage at a competitive price and save considerably on the physical and human resources 

required to print and post. Docmail also, very helpfully, provides a print server which, once installed, 

enables the process to be completed by simply printing to the Docmail Print Server. 

Important: You should check any proof letters carefully using a barcode scanner to ensure that the NHS 
number barcode has been created successfully. Any mistakes at this stage could be extremely costly! 

Clinic Procedure 

 Patient joins queue of patients – Signage and staff ensure that the patient has ticket ready and 

has removed outer layers of clothing. A verbal check about allergies etc. can also be carried out 

at this stage.  

 Patient hands ticket to clinician at time of vaccination 

 Ticket placed in one of two containers (left arm / right arm) 

 Vaccination given 

 

Note: If more than one batch of vaccine is used, an appropriately labelled container of right and left arm 
tickets will need to be created for each batch. 
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Creating Lists of Patients 
The aim is to create two lists for each batch of vaccine administered: 

 Patients vaccinated in the left arm 

 Patient vaccinated in the right arm 

The following procedure for patients vaccinated in the right arm, should be repeated for patients 

vaccinated in the left arm: 

 Open a new document in Notepad 

 Insert the cursor at the start of the document and scan the first ticket 

 Each time a barcode is scanned the cursor should automatically move down to the next line in 

the document, ready for the next barcode to be scanned 

 Scan all of the tickets of patients vaccinated in the right arm 

Once all of the tickets have been scanned a column of NHS numbers will have been created. You may 

wish to record the name of the person administering the vaccination. If so, you should keep separate, 

labeled containers detailing the clinician’s name and follow the process above for each clinician. 

Barcode Scanning Tips 
If you are unsure if you have scanned a ticket, scan it again. EMIS will remove duplicates automatically 
when you import the list so this will do no harm. 
Some of the tickets will be creased etc and the barcode unclear. It is still often possible to scan the 
barcode. However to ensure accuracy, you should cross reference the number which scans into Notepad 
with the backup NHS number printed in standard font. You should include a second barcode on the 
ticket as it is rare for both of these to be unusable due to wear. 

Saving the List in the Correct Format 
EMIS requires the Notepad document to be saved as a .txt file (the default file type for Notepad). 

In Notepad: 

 Click “File” > “Save As” and select a secure drive/folder 

 Name the file so that you can differentiate between the right arm list and the left arm lists (and 

between different batches and clinicians if applicable) e.g. “Flu Vaccination 20th Sept RIGHT ARM 

– Batch 123 - Dr Sharp.txt” 
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Importing the List of Patients into EMIS Web (Single Practice Clinic) 
In EMIS Web: 

 Click “Reporting”  “Population Reporting” 

 Create or navigate to an existing folder on the left window pane, in which to save the list of 

patients 

 Once the target folder is selected, click “Add”  “List of Patients” and a new window will open. 

 Assign a name to the list you wish to create and add a description e.g. “Flu Vaccination 20th Sept 

RIGHT ARM – Batch 123- Dr Sharp” 

 Click “Import” and a new window will open to enable you to browse to the txt file containing the 

list of NHS numbers 

 Select the saved txt file and click “Open” 

EMIS Web will analyse the list of NHS numbers and match them to patients. This may take a moment or 

two to complete. 

The imported list will appear in the selected folder, in the same way that a search population is usually 

displayed. The vaccination data can be added to all the patients on the list as a batch process. If you 

wish to record the name of the clinician who administered the vaccine, you can enter this in the 

“Descriptive Text” field. 

Data should be entered on the databases of all practices involved as soon as possible after the 
vaccination clinic. This will prevent difficulties, should any patients leave the practice soon after being 
administered the vaccination.  

Importing the List of Patients for Multiple Practice Clinics 
The barcoded system can be used when vaccinating patients from multiple practices at a single 

site/clinic. The list of patients should be created and imported as described for single practice clinics 

above. During the importation process, EMIS Web will recognise patients who are, or have been, 

registered at the practice where the list is imported; all other NHS Numbers will be ignored.  If a patient 

has been registered at one of the practices and subsequently registered at another, EMIS web will 

recognise the NHS number and will add the data even though the patient is no longer registered, which 

is clearly undesirable. To manage this issue, a further step is required to filter out these patients before 

batch adding the data. The following process should be carried out at each participating practice. 

 Import the list of NHS Numbers as described in the previous section (Importing the List of 

Patients into EMIS Web (Single Practice Clinic)) 

 Download the search “Flu Clinic Own Practice Filter” using the link below, and import it into 

folder containing the imported list – This search identifies patients who are currently registered 

at the practice with regular registration type. 

https://www.dropbox.com/s/8ff29knxvgw2g7l/Flu%20Clinic%20Own%20Practice%20Filter.xml?dl=0 

 Select “Properties” for the imported search file 

 In  the “Based on” section, select the “Results from” radio button 

 Click the magnifying glass to browse to the imported list of patients 

 Click OK 

 Run  the “Flu Clinic Own Practice Filter” search 

 

https://www.dropbox.com/s/8ff29knxvgw2g7l/Flu%20Clinic%20Own%20Practice%20Filter.xml?dl=0
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 Batch add the vaccination data (described in the next section) to the records of patients 

included in this search result 

 Repeat the filtering process for each imported list 

Batch Adding the Vaccination Data 

 Select “Batch Data Manager” from the tabs in the Population Reporting screen. 

 Click “Add”  “Clinical Code” and the “Add Batch Data” window will open. 

 

 
 

 Click on the magnifying glass next to the “Batch Add” field to select the seasonal influenza 

vaccination code. The “Add a Code” window will open 

 Browse to the correct code and double-click it. A pane will appear at the bottom of the “Add a 

Code” window, enabling the entry of the flu vaccination details 
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 Complete the details ensuring that the “Date of Entry” field contains the date that the 

vaccinations were actually administered rather than today’s date 

 Click “OK” and you will return to the “Add Batch Data” window 

 Complete the description field (this will appear only in the Batch Data Manager screen and not 

in the patient record) 

 In the “List Type” field select “Search Population (Included)”  

 In the “Search Population Included” field, browse to the folder containing the imported list of 

patients. It is critical that you make the correct selection at this point 

 Click “OK” 

 
 

A “Batch add clinical code” confirmation window will open asking you to confirm you wish to make the 

batch change 
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 Ensure that you check all the details are correct as you will only have a 7 day period within 

which you can undo the batch addition 

 Click “Add Batch” to confirm you wish to make the batch change 

The batch change status will appear as “running.” It may take several minutes for the process to 

complete and this will be confirmed by the status appearing as “Complete.” (You may need to 

periodically click the “Refresh” button to update the status) 

 

 

 

 Check that the process has succeeded by viewing an included patient’s Care History 
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System Requirements 
Microsoft Office 

EMIS Web 

Notepad 

Free 3 of 9 font installed 

Docmail Print Server (recommended) 

USB barcode scanner  

 

Disclaimer 
Although the author and publisher have made every effort to ensure that the information in this 

document was correct at press time, the author and publisher do not assume and hereby disclaim any 

liability to any party for any loss, damage, or disruption caused by errors or omissions, whether such 

errors or omissions result from negligence, accident, or any other cause. 


